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Generation and Processing of Ray Data from an LED 
Measured with the RiGO801-LED Goniophotometer 

This Application Note explains how ray data can be generated from the TTR file of a 

measured LED and exported in various file formats. It provides all the necessary 

fundamental knowledge and concludes by demonstrating how the TTR file can be 

prepared for general applications using the free conversion software Konverter801. 
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TechnoTeam Ray Data in TTR File Format  

The TechnoTeam RiGO801 Goniophotometer utilizes the near-field measurement 

principle in combination with an Imaging Luminance Measurement Camera (ILMD, see 

[1]) to measure ray data. This data is initially stored in the proprietary TechnoTeam TTR 

format. Using the free Konverter8011 software, the ray data can subsequently be 

converted into common standard formats, such as IES TM-25 [2], ASAP, Speos, 

LightTools, LucidShape, Zemax and TracePro. 

A detailed description of ray data measurement using an LED as an example can be 

found in Application Note AN2002 [3]. The following sections focus exclusively 

on the post-processing of the measured data. 

Ray data 
A ray in this context refers to the luminous flux or radiant flux 

emitted from a (virtual) surface element of a light source in a 

specific direction. In addition, a ray can be associated with 

further properties, such as spectral data. A sufficiently 

large number of such rays allows for an accurate 

representation of the light source’s emission 

characteristics. The resulting dataset is referred to as ray 

data, commonly known as rayfile or ray set. 

Ray data is a fundamental component in the development 

of optical systems, as it provides a realistic 

representation of light sources within the optical system, 

enabling precise simulations and design. 

Generation of Rays from the TTR File Format 
In a TTR file, the measured ray data is stored in a preprocessed format as a sequence of 

images (see Figure 2). Each image is associated with a specific camera position within 

the goniometer coordinate system. 

 

Figure 2: Sequence of ray data images 

To calculate a vector from the image coordinates of a ray, both the camera position and 

the precise definition of the camera coordinate system are required (see Figure 3). The 

center of the camera coordinate system corresponds to the projection center of the lens. 

Through a coordinate transformation, a vector is generated in the goniometer 

coordinate system, with its starting point located on a spherical surface. This spherical 

                                                           
1 https://www.technoteam.de/produkte/goniophotometer_rigo801/rigo801_software/konverter_801 

Figure 1: Illustration of a Ray 
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surface is defined by the distance between the lens projection center and the coordinate 

system origin (camera radius, see Figure 4). 

Each ray is assigned a portion of luminous flux, which is calculated from the luminance 

image. All the necessary information for ray calculation, including camera and 

coordinate data, is fully contained in the TTR file. 

 

Figure 3: Camera coordinate system 

The calculated rays initially originate 

from a spherical surface that is 

relatively far from the light source. 

While this distance is irrelevant for 

describing the emission 

characteristics of the light source, it 

can become problematic during 

raytracing in optical simulations. 

Optical components are usually 

located in close proximity to the light 

source, so the ray starting points 

should ideally be positioned in front 

of these components. 

When generating rays from a TTR file, the starting points can be shifted to a so-called 

target geometry using raytracing algorithms. Available target geometries include sphere, 

cuboid, and cylinder. The target geometry should be defined as a bounding surface that 

closely encloses the light emission volume. However, care must be taken to avoid 

intersections (undercuts), as rays that do not intersect with the target geometry will be 

discarded. 

To define the starting points of the rays relative to the target geometry, two modes are 

available: 

 

Figure 4: Ray in the goniometer coordinate system 
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1. Surface Mode (Default): In this mode, the starting points of the rays are shifted 

to the surface of the target geometry (see Figure 5). This is the most common 

approach, as it positions the rays on a clearly defined boundary surface. 

2. Volume Mode: In this mode, the starting points are shifted to the midpoint 

between the entry and exit points of the rays through the target geometry (see 

Figure 6). This approach is particularly useful when the positioning of rays inside 

the volume of the target geometry is required. 

 
Figure 5: Raytracing on target geometry in surface mode 

 
Figure 6: Raytracing on target geometry in volume mode 

As the final step of the coordinate transformation, the rays can, if necessary, be 

transferred to a target coordinate system through rotation and translation. This 

transformation ensures that the rays are precisely aligned with the requirements of 

specific optical simulations or the coordinate system of the target application. 

 

Figure 7: Target coordinate system 

Export of Ray Data into Various File Formats 
The calculated rays in the desired quantity can be exported into various standard 

formats. The formats used by popular simulation programs (e.g., LightTools, Zemax, 

TracePro, and ASAP) are generally similar in structure. These files primarily consist of a 

file header followed by a list of rays, including: 

 Starting coordinates 

 Direction vectors 

 Amplitudes 

 Optional additional data 
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To optimize storage and processing efficiency, the data is typically stored in binary 

format. 

The IES TM-25 format [2] was developed to standardize the diverse range of file formats 

and reduce the associated effort. It provides a universal standard that enables the 

efficient and consistent use of ray data across various simulation applications. 

Generation of Ray Files for the Measured LED 

This section provides a detailed explanation of the steps involved in generating a ray file. 

The process is based on the TTR measurement data of a white LED, specifically the ams 

OSRAM LCW CP7P (see Application Note AN2002 [3]). Using this data, the procedure for 

generating and processing ray data up to the creation of a ray file is outlined step by 

step. 

Opening the TTR File 
Using “File → Open …”, the desired TTR measurement file is selected, in this case, 

“Osram-LCW-CP7P-Photometric.ttr”. Once opened, a window appears that provides an 

overview of all the information contained in the TTR file (see Figure 8). This window 

offers a structured display of the data, including detailed information about the 

measurement parameters and the captured ray data. 

 

Figure 8: Window (upper section) with TTR Data Overview 

A detailed description of the individual tabs can be found in other documents (AN2002 

[3], Measurement Manual [5], Konverter801 Software Manual [6]) and will not be 

covered here. For the further procedure, the images of the LED alignment within the 

goniometer coordinate system, included in the additional data, are particularly relevant. 

Defining the Target Geometry and Target Coordinate System 
To define the target geometry of the ray data, precise knowledge of the LED's position 

within the goniometer coordinate system is essential. This information can be obtained 

from the images of the LED alignment. These images are either provided as external files 

or, as in this case, embedded as additional data directly within the TTR file. They 

illustrate the exact position and orientation of the LED during the measurement, 

ensuring an accurate definition of the target geometry. 

The additional data contains several images, initially numbered sequentially (see Figure 

9). Each image is available in two versions: a screenshot in .bmp format, which shows 

the view as used by the operator, and a complete camera image in .pus format, which 

includes additional information such as the coordinate system. The .pus format provides 

enhanced detail, making it particularly useful for further analysis or adjustments. 
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Using the camera image is often recommended, as settings 

such as zoom, scaling, and color palette can be adjusted 

flexibly if needed. In the further course of this Application 

Note, these data will be processed to optimally prepare the 

TTR file for external use. 

Figure 10 illustrates the position of the LED within the 

goniometer coordinate system using the two essential 

alignment images: top view and side view. The orientation 

and positioning of the coordinate axes are displayed in the 

top-left corner. The Z-axis points in the direction of the LED’s 

emission, while the X/Y plane lies on the top surface of the 

LED housing. 

   

Figure 10: Alignment images of the LED in the goniometer coordinate system 

A cylinder or a sphere can be used as the target 

geometry. For initial investigations, a cylinder is 

defined that encloses the LED lens. The cylinder 

has a diameter of 2 mm and a height of 1.6 mm. 

Due to uncertainties in the LED's positioning and 

its actual dimensions, it is recommended to add 

an additional margin, such as 0.1 mm. This results 

in a cylinder with a diameter of 2.2 mm and a 

height of 1.8 mm. 

The center of the cylinder is positioned on the Z-

axis at Z = 0.8 mm. These settings can be configured under "Options → Target Geometry 

…", as shown in Figure 12. 

 

Figure 9: Alignment images in 
TTR additional data 

 

 

Figure 11: Outline of the cylinder target 
geometry 

 

mailto:support@technoteam.de


 

Application Note 

 

 

E-Mail: support@technoteam.de Website: www.technoteam.de 6 

 

 

Figure 12: Configuration of the cylinder target geometry 

Finally, if needed, the target coordinate system for the ray data can be specified. This 

configuration is set under "Options → Target Coordinate System" and depends on the 

requirements and preferences for handling ray data in the chosen simulation programs. 

In this case, no additional transformations are applied. 

Verification of the Target Geometry 
To verify whether the chosen parameters 

for the target geometry are suitable, a test 

dataset of ray data is generated, for 

example, in LightTools format (Convert → 

LightTools Ray File (*.ray)). It is 

recommended to initially use a ray count 

of 1 million. 

After the conversion process is complete, 

the "Number of Rays" field in the 

Conversion section displays the actual 

number of rays written to the file. Rays 

that do not intersect with the target 

geometry are excluded from the file. This 

count serves as a key indicator of the 

suitability of the chosen target geometry. 

If the deviation between the desired and 

the actual number of exported rays 

exceeds 1%, the origin of the excluded 

rays should be investigated. To do this, 

activate the option “Save excluded rays” in the target geometry settings dialog. 

When this option is enabled, an additional file with the suffix “_excluded” is created. This 

file contains only the rays that did not intersect with the target geometry. These rays can 

 

Figure 13: Dialog for generating a rayfile 

 

mailto:support@technoteam.de


 

Application Note 

 

 

E-Mail: support@technoteam.de Website: www.technoteam.de 7 

 

be analyzed in a simulation program by 

tracing them back onto appropriate 

planes. This allows insights into the 

source and distribution of the excluded 

rays. 

To ensure that the number of excluded 

rays is sufficient for meaningful analysis, 

a dataset with 100 million rays was 

generated in this case. 

The result of raytracing these rays onto 

the x/y plane is shown in Figure 14. As 

expected, significant portions of the LED 

emission reflect off the LED housing and 

the PCB, particularly in the near-field 

region. If this ~2% of rays is to be 

included in the ray data, the target 

geometry needs to be expanded. In this case, a 

cuboid target geometry with dimensions 3.2 

mm x 3.2 mm x 1.8 mm would be more 

suitable. 

A subsequent test conversion with these 

updated parameters resulted in only 1% 

excluded rays, indicating that this target 

geometry is appropriate. These parameters 

have been adopted for the final configuration 

(see Figure 15). 

Defining Surface or Volume Mode 
By selecting the cuboid geometry and 

extending it to match the dimensions of the LED housing, the distances between the ray 

starting points and the actual light-emitting areas become significantly larger. This can 

be disadvantageous for simulations, making the volume mode potentially more suitable 

than the surface mode. However, positioning the ray origins inside the LED could raise 

additional questions, so the choice of raytracing mode should ideally be discussed with 

an experienced user of optical simulation software. 

Figure 16 and Figure 17 visualize the starting points for both modes. 

 

Figure 14: Raytracing of excluded rays onto the X/Y plane 

 

 

Figure 15: Parameters of the final target geometry 
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Figure 16: Ray starting points in surface mode 

 
Figure 17: Ray starting points in volume mode 

Preparation of the TTR File for General Application 

The previously defined settings are now to be embedded into the TTR file. To do this, 

navigate to the menu option “File → Edit …”. This opens the familiar results window, but 

with extended functionality in this mode. The available options in this window are 

described in the following sections. 

Details of measurement 
In this tab, all measurement details can be edited. This includes general information, 

such as the measured luminous flux, as well as internal details, like camera settings or 

file paths. If the TTR file is intended for use by parties outside the organization, it may be 

advisable to remove such internal information. The relevant sections can be selected 

using the checkboxes and deleted via the “Delete” button. 

The most important setting on this page is the section “Export of ray data: Target 

geometry and coordinate system”, where these parameters are defined for embedding 

into the TTR file. Typically, these parameters have already been defined and verified 

beforehand, so they can now be applied by simply clicking the “Take global settings” 

button (see Figure 18). Alternatively, it is also possible to manually enter the parameters 

directly in this section. 

 

Figure 18: Parameters of the target geometry and target coordinate system in the TTR File 

mailto:support@technoteam.de


 

Application Note 

 

 

E-Mail: support@technoteam.de Website: www.technoteam.de 9 

 

Removing Optional Data 
Certain data included in the measurement file are often not relevant to the general 

audience and can be removed from the file. To do this, select the corresponding tabs and 

click the “Delete” button. The following data types can be removed: 

 Measurement Devices: Data captured by external measurement devices during 

the process, such as temperature or electrical parameters. 

 Stabilization Phase: If the measurement was initiated using the automatic 

stabilization function, the data for this phase is displayed here. 

 Pole Monitoring (Graphics and Table): This section contains illuminance 

values measured at the poles, which are only relevant for assessing the LED’s 

stability during measurement. 

Spectral Data 
This section allows the assignment of a spectral 

distribution (spectral radiant flux) to the TTR file. The 

spectrum can be utilized during the generation of 

spectral ray files or serve as an informative dataset for 

reference purposes. 

By clicking the “Load …” button, a suitable spectral file can be opened (see supported 

formats in Figure 19). In this case, a goniospectrometric measurement in the 

TechnoTeam TSD format is loaded, and the relative spectral radiant flux is extracted for 

further use (see Figure 20). 

 

Figure 20: Spectral data embedded in the TTR File 

 

Figure 19: Supported spectral data file 
formats 
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Additional data 
The TTR additional data serves as a data container where various types of data can be 

structured and embedded. In the current measurement file, the LED alignment images 

are included. Depending on the target audience, it may be helpful to retain these images 

in the file or replace them with a processed document instead. 

However, it would not be practical to include these images if the target coordinate 

system has been changed, as the LED's measurement position would no longer 

correspond to its position in the ray file’s coordinate system. 

Here, as an example, the list of images is 

reduced, and the two most important 

images are renamed. Additionally, two 

subfolders are created to include the 

complete goniospectrometric 

measurement data and the LED datasheet. 

  
 

Figure 21: Edited TTR additional data 
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Generating Ray Files with the Processed TTR File 

Single Processing 
After loading the file, the 

conversion dialog for the desired 

format is selected. It is essential to 

activate the option “Use target 

geometry and coordinate system 

from TTR source file” to ensure that 

the embedded parameters are 

applied during the conversion 

process (see Figure 22). 

To illustrate the outcomes, a large 

file containing 100 million rays is 

generated. These rays are then 

traced back to the X/Y plane for 

analysis.  

  
Figure 23: Raytracing on the X/Y plane (Linear and Logarithmic representation) 

Batch processing 
If multiple file formats need to be generated, possibly with varying numbers of rays, 

single conversion can be time-consuming and tedious. To address this, the “Convert → 

Batch Processing” function offers a much more convenient alternative. 

 

Figure 22: Generating a ray file from the processed TTR file 

 

mailto:support@technoteam.de


 

Application Note 

 

 

E-Mail: support@technoteam.de Website: www.technoteam.de 12 

 

With batch processing, multiple conversions can be automated by predefining the 

desired parameters and target file formats. This saves time and reduces manual effort 

significantly. 

A detailed description of this feature can be found in the Konverter801 software manual 

[6], which provides a step-by-step guide to using batch processing effectively. 

Summary 

This Application Note demonstrated how to generate ray data from a measured TTR file 

and export it into various file formats. All the necessary fundamental knowledge was 

provided, particularly the definition of the target geometry. Additionally, it was shown 

how to analyze data measured outside the LED's light-emitting volume, such as 

reflections from the LED housing or the PCB. Finally, the TTR measurement file was 

prepared to ensure its usability for general applications without requiring detailed 

knowledge of the measurement process. 

A further topic is the generation of spectral ray data, particularly for white, phosphor-

converted LEDs. This subject is covered in detail in a separate Application Note. 

 

  

mailto:support@technoteam.de


 

Application Note 

 

 

E-Mail: support@technoteam.de Website: www.technoteam.de 13 

 

References 

 

[1]  CIE, „CIE 244:2021 Characterization of Imaging Luminance Measurement Devices (ILMDs),“ CIE, 

Vienna, 2021. 

[2]  IES, „IES TM-25: Ray File Format for Description of the Emission Properties of Light Sources,“ 

Illuminating Engineering Society, New York, 2020. 

[3]  TechnoTeam Bildverarbeitung GmbH, „Application Note AN2002 - Measurement of Ray Data of 

an LED Using the Goniophotometer RiGO801-LED,“ 

https://www.technoteam.de/main/learn_more/application_notes/ray_data_measurement_of_

an_led/index_eng.html. 

[4]  TechnoTeam Bildverarbeitung GmbH, "RiGO801 Measuring program," [Online]. Available: 

https://www.technoteam.de/products/goniophotometer_rigo801/rigo801_software/rigo801_

measuring_software/index_eng.html. 

[5]  TechnoTeam Bildverarbeitung GmbH, „Software manual Converter801,“ 

https://www.technoteam.de/products/goniophotometer_rigo801/rigo801_software/converter

_801/index_eng.html. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Kontakt 
TechnoTeam Bildverarbeitung GmbH 

Werner-von-Siemens-Str. 5, 98693, Ilmenau, Germany 

E-Mail: support@technoteam.de 

Phone: +49 (0) 3677 / 4624-0 

www.technoteam.de 

mailto:support@technoteam.de
mailto:support@technoteam.de
https://www.technoteam.de/

